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Chapter 1

CFME

1.1 Cannon Fodder Map Editor

Cannon Fodder Map Editor V1.90/1.01 - Copyright Nicola Wrachien
---------------------------------------------------------------

Note: this guide is not complete yet

Introduction What does it do
Legal Notice You should read this...
Requirements What do you need
Installation How to install it
Distribution Where it can be placed
NEWS SINCE 1.80/1.00 Read these news!

Features What can it do
Usage How to use it
ToolTypes External setting
Building maps Please read those conventions

Bug Report What you have to do if you discover a bug
List of known bugs Bugs that will be fixed soon (I hope...)
History The story so far...
Future What’s next
Registration Please, register! It’s free
The Author About the Author
Greetings People I would thank

Sorry for my bad english!

Please note that Catalogs files are not updated. So new windows, menus,
etc... are only in English.

1.2 News about CFME

From 1.80 CFME will become a package of various things:
There will be:

- CFME: the main editor
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- example drawer: a directory containing some maps and other files

- exe drawer: a directory containing an executable file to make some
CFME’s feature available. You have to put it on your Cannon
Fodder drawer.

- Utility drawer: this will contain some utilities (like graphics
converters - BLK2IFF_IFF2BLK) that allow you to
change graphics and (later) sounds of CF.

CFME, as archive, will have two version numbers: one referred to CFME main
editor (the file named "CFME"), and the second will be referred to the
version of the content of Utilities drawer. Note that Utilities dir will
have, as version number, the sum of ALL utilities’ version numbers

How do the version numbers mean:

EXAMPLE: V5.43/2.10

The value 5.4 means great amount of new options (like objective editor
preferences, diff. editor, block editor, grids, etc: all these are new
options.). The Number 3 means that I made to the current version (5.4)
3 small improvements or bug fixes. A value of 4 (in the same place - second
decimal digit) means a four bug fixes and so on.

Number 2.10 may mean that:
- there is only one utility which has been changed many times with many

and important options (Example: it could be a sprite editor option added
to IFF2BLK_BLK2IFF file ...). No bug fixes.

- there is more than one utility and the sum of it’s version number is 2.1
(example IFF2BLK_BLK2IFF V1.00 and a sound editor V1.10)
Maybe no bugfixes. (2.10 may be the sum of 1.08 and 1.02... and so on)

1.3 Changing / converting CF graphics

How to change CF icon graphics:

Double click on the BLK2IFF_IFF2BLK file in the utilities drawer (very
difficult!)

This name means "Cannon Fodder .blk files to IFF and vice-versa"

NOTE: This utility can’t read RNC crunched files. If your .blk files are
crunched you have to decrunch them manually

BLK to IFF:

Load a BLK file and then its palette. (By using the menu)
Save the IFF file and then modify it with any program like PPAINT, Dpaint
etc. DON’T CHANGE THE IMAGE ATTRIBUTES! (ie size and depth)

IFF TO BLK:

Load the iff file then save it the .BLK format. IFF and BLK Attributes



CFME 3 / 20

must be the same (ie you can’t save a morsub.blk file on a morbase.blk)
Save the pal file if you made any change to the palette. (I suggest you to
not to modify palette until I make a complete graphics editor.)

IFF TO CFME:

To be able to use the new graphics in CFME you have to change CFME data/
files. You’ll may do it by hand but I don’t suggest you it.
So I made a little feature on this utility.
You have to:
-Select Save as CFME in the CFME menu. A window will appear.
-Select the name of the file you want to change. (ie if you have converted
the file icesub.blk to iff, then you changed it, so you want to edit maps
with the new graphics, select the "icesub" button.)
-Select SAVE AS CFME IFF in the project menu.
-Select the CFME Data/ dir

Now should be able to see in CFME your new graphics.

1.4 Conventions

Note: this convention has been planned by Alexi Tzitzas

When you’ll finish a map, I pray you to upload it on Aminet (or send it to
Leki - Alexi Tzitzas. Go to http://web.ukonline.co.uk/alexi.t/index.html
for more informations) and to include in the archive a map descriptor like
the one below:

-Map description: small map with buildings, you start off surrounded by
the enemy and will need skill, a bit of luck and good
timing to complete it.

-Title: Destroy all PCs
-GFX type used: jungle0
-Difficult Comments: hard
-Version: 1.1
-Map Author: Alexi Tzitzas
-Contact detail: alexi.t@ukonline.co.uk
-Time to design: 45 minutes
-Editor used : CFME 2000 (i.e. version)
-Notes: blahh

1.5 Features

Features:
=========

- Locale support and emultaion (for WB2.0)
- Installer utility
- Can edit or create maps
- Can edit sprites type and positions
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- Can find out sprites in the map
- Can handle user blocks in order to build maps quickly
- Can edit mission objectives
- Can edit difficulty levels (ie how fast enemies fire, walk)
- Saves every xx changes or minutes
- Can edit all type of maps
- Fully configurable (screen pens, colors etc)
- Supports GFX boards
- Runs on all processors (68000 not tested yet - only with UAE)
- Can display grid on icon and map windows
- It’s very easy to use
- Can edit icon graphics of CF - CF2!!!
- Can (in part) support CF 2
- Can edit how icons change when hit by an explosion (ie you can make all
your maps completely destroyable!!

1.6 Introduction

Have you ever wanted to make or change your own maps for Cannon Fodder?
Do you want to have more or less jeeps/tanks/chops in any phases?
Don’t you like Cannon Fodder graphics? Do you think you can do it better?

Well, with Cannon Fodder Map Editor you’ll be able to do that!!!
And it is freeware !!!

1.7 Disclaimer

LEGAL NOTICES, PLEASE PAY ATTENTION AND READ CAREFULLY:

This program is provided AS-IS without any type of guarantee.
Use it at YOUR OWN RISK: it certainly contains bugs of various type:
I WILL NOT BE RESPONSIBLE FOR ANY DAMAGE* CAUSED BY THE PROPER OR
IMPROPER USE OF THIS PROGRAM. YOU’LL HAVE TO PAY ALL COSTS IF
SOMETHING GO WRONG.

NO ONE CAN BE HELD RESPONSIBLE FOR ANY DAMAGE THAT CFME CAN DO.

*NOTE: DAMAGE ARE ALSO - BUT NOT RESTRICTED TO - LOSS OF DATA,
SOFTWARE CORRUPTION etc.

Cannon Fodder Map Editor (CFME) and its archive is Copyright of Nicola Wrachien.
All rights Reserved.
Although it is Freeware it is NOT PD.

You can’t change any part of this archive without my WRITTEN permission

Cannon Fodder is copyright of Sensible Software
Published by Virgin Interactive Entertainment Ltd.

CFME is not, in any way, endorsed by Virgin Interactive or Sensible
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Software.

"Fodder" file is a non crunched version of "fodder" file of the CF Hd
installer by Jean Francois Fabre, TRIANGLE etc... It’s needed for some
CFME features. Without it those features would be unavailable. (CFME
have to change some datas in the executable file so CFME needs a non
crunched "fodder" file - Thanks to Andrzej for sending it)

1.8 Changing objectives

Note: this is not complete yet:

-Select fodder exe file.
-Select import from game or load a presaved .obj file
-Select the map you want to change objectives
-Change the objective you want
-Save to an .obj file (if you want to store or share your objectives)
-Click on save if you want to use your new objectives. (It’s better to
make a copy of your old - and new - fodder file)

1.9 Difficulties

Note: this is not complete yet:

-Select fodder exe file.
-Select import from game or load a presaved .dif file
-Select the map you want to change difficulty levels
-Change the two difficulty levels. Speed will affect the walking speed
etc... and Weaps will affect the range and the fire rate of their weapons
-Save to an .dif file (if you want to store or share your .dif files)
-Click on save if you want to use your new difficulty levels. (It’s better
to make a copy of your old - and new - fodder file)

(NOTE: don’t use too high values as CF will become unplayable. I suggest
you to keep values below 32)

1.10 Requirements

Requirements

CFME needs to run:

-An Amiga ;-)
-at least 1MB of free mem (at least 300-400 k must be of chip)
If you are using resolution higher than 320x256, 2 MB are the minimum
-Os 2.0+ (sorry only now I discovered that it crashes on 1.3!)
-Cannon Fodder installed on HD

That’s all.
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1.11 How to install it

Once unpacked it’s ready to use. But I made an installer (so you can unpack
it into ram: and install it on HD - suggested)

It’s better to add to user startup the following line:

assign CF: <path where CF maps file are>

It’s not necessary but it’s suggested since I use this assignment as default
in .config file.

If you have WB2.1 or greater (with the env variable "language" in ENV: ) the
language chosen will be (if available) the same of your WB.

If you have WB2.0 OR your language isn’t supported you can select it using the
ToolTypes.

You may also select the directory where are the catalogs file installed in
by using the tooltypes. (so you can move the catalogs dir in DATA/ in your
LOCALE: directory.)

NOTE THAT THE PROGRAM IS LOCALIZED EVEN IF YOU DON’T OWN WB2.1+: it has a
locale.library emulation.

Currently supported languages:

English (Default)
Italian

*** NOTE: ***

Remove the LANGUAGE TOOLTYPE if you want to select WB’s language.

(ToolTypes have more priority than ENV: settings)

1.12 Distribution

You can (and you are encouraged to) spread the ORIGINAL ARCHIVE all over the ←↩
world!!

You must distribute it freely (you can charge the cost of a disk or a CD of PD- ←↩
free-shareware programs)

Spread it on Aminet BBS, Web Sites, CDs (for example: Aminet, Amy Resource, EAR- ←↩
CDs etc..) etc...

IT MUST BE AS THE AUTHOR PROVIDED IT. IT CANNOT BE CHANGED OR DISTRIBUTED ONLY IN ←↩
PART.

1.13 How to use it
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NOTE: This part is STILL in development

How To List of what you have to do for ...
Windows Not those ones by MicroZoft ;-))))
Menus ...
Preferences the preferences window

1.14 Menu

- Project Menu
- Edit Menu
- Program Menu
- Map Menu

1.15 Project menu

From this you can see:

- Load Map - Loads a map
- Save Map - Saves a map
- Load SPT - Loads sprite position file
- Save SPT - Saves sprite position file
- Load Phase - Load Both .MAP and .SPT file
- Save Phase - Save Both .MAP and .SPT file
- About - About the Author and CFME
- QUIT - Exit to Wb/Cli

1.16 Program Menu

This menu will allow you to open the windows

Sprites - opens the sprite window
icon - opens the icon window
Prefs - opens the preferences window
Grid on icon window - draws grid on icon window
User Blocks - allows you to speed up map building
Objectives - allows you to change mission objectives
Difficulty - allows you to change levels of difficulty
Icons prop editor - allows you to change icons properties

1.17 Grid on icon window

Sometimes Getting the right icon is difficult because we can’t see where
icons start and where they end. So by ticking this check menu a grid
will be drawn in the icon window.
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1.18 How to put Block

Blocks are groups of icons predefined by the user.
They speed up the building of the map because some elements (like buildings
trees) are repeated on the map. So user can make a block and put it
(instead of single icons) on the map just like if it would be an icon.

You can define 10 blocks and you can save/load them. They have size from
1x1 to 5x5. You can copy icons (for example those ones which are very used
but are difficult to find out from icon window) in a block with 1x1 size.

You can add a name to your blocks (maximum 9 chars)

HOW TO BUILD BLOCKS:

- Select in the Program menu "User Blocks".
- Two windows will open - work on the bigger one
- Select the block you want to change/create and select the size (Note
you can change size of a block without losing your work)

- Add it a name (if you want) in the string gadget (press return once
you have finished, otherwise name won’t be saves)

- Build the block as you would be building a map.

HOW TO PUT:

- If the smaller one "User Blocks" window isn’t open, select "User Blocks"
in the "Program" menu.

- Select the block you want (here’s the usefulness of the names...)
- click on the map icon to put the entire block

1.19 Edit Menu

In this menu there are:

- Base - select the terrain type
- Change dim - set map dimensions
- Change Max Spr - change total number of sprites

1.20 Map Menu

This menu allows to change the way the map (or its contents) is displayed.

No Sprite -Disables Sprites
Show sprite n -Shows Sprite n on each sprite
Text+Borders -Draws text with borders
Grid -Draws a grid in the map

See also how to Show and hide texts
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1.21 Windows

There are four windows:

-Map Window
-Sprite Window
-Icon Window
-Preferences window
-User Blocks windows

1.22 Map Window

Here you can put icons or objects.

1.23 Icon Window

The window that allows you to select an icon. See How to select an icon.

1.24 Sprite Window

In this window you can select, change and find your sprites in the map.
See How to select and place a sprite for detailed informations.

1.25 How to change pens and palette

By choosing "Colors" menu in the preferences window you will be able to
change all the screen pens (text, windows texts...) used in the editor.
A window will open and you will see some coloured boxes (as many as the
number of colour on screen) and a listview. To change a screen pen you
have to:
-select a pen in the listview (it becomes the currently used pen)
-select the colour box you want (so the pen you chosen will use this colour)
-Save, quit & reload CFME

To change palette you have to choose the "Palette" menu in the prefs
window. So you will see 3 slider and the usual coloured boxes.
Select the colour you want to change (It must be a colour NOT used by CF)
and select the amount of red green and blue.

1.26 Changing icons properties
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HOW TO CHANGE ICON PROPERTIES:

There are several properties of CF icons.
By selecting "Icons prop editor" in the "Program" menu you can modify
how icons change when they are hit by rockets, bombs etc...

Once you have selected "Icons prop editor" you will see a new window.
Every icon can have two states: normal and destroyed states.
Of course, the destroyed icon can have a normal and destroyed states and
so on.
If the destroyed state is equal to the normal one, that kind of icon can
be hit infinite times and it will explode every time it’s been hit.

To load the file which contains those information select the new window
and, in the project menu choose "load swp". Then you have to enter a
name in the file requester.

NOTE: The name can be:

-first three letters of the terrain type (es: ICE or MOR or INT etc..)
-one file which has the first 3 initial equal to Ice, Jun, etc...

We can modify the destroyed state by selecting "show destroyed" in the
"Window" menu and putting icons on the grid. (get the from the icon window)
Note: black icons (you can get it from the icon window: it’s at the right

bottom corner) mean a indestructible icons.

To save choose "save" or "save as" (to change name) in the project menu.

NOTEs:

-Only first 3 chars of the names are considered. This prevents errors.
-There are two types of jungle: jungle0 and jungle1. To choose which one
to edit you must select file: junsub0.swp or junsub1.swp.
-Always edit the .swp file of the same terrain type chosen in the Base submenu.
Ie if you chose "desert" you must edit the "des" .spt file

1.27 How to ...

HOW TO:

Select & put an icon
Select & put a sprite
Find a sprite in the map
Change map dimensions
Change number of sprites
Create a new map
Chose terrain (base) type
Load & save a map
Load & save sprites positions
Load & save sprites & map
Use Preferences
Show/Hide sprites on the map
Change screen mode
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Change screen pens and palette - New since 1.50
How to build & put blocks - New since 1.60
How to change objectives - New since 1.70
How to change difficulty levels - New since 1.80
How to create/convert graphics - New since 1.80/1.00
How to change icons proprerties - New since 1.90/1.01

1.28 HOW TO CHANGE SCREEN MODE

It’s symply. Go to the Prefs window and select Screen Mode.
An ASL requester will appear and you have to select the screen mode.
Once you have selected click on "Save" and reload CFME.

NOTE: The screen MUST have 320 x 256 size minimun. (Aga, Ecs, Graphics
boards ...)

It can have any depth but I suggest you a minimum depth of 4.
DEFAULT: Pal 320x256x5 BitPlanes (32 Colours)

1.29 Selecting and putting an icon in the map

To put an icon you must firstly have done one of these operations:

- Set map dimension
- Loaded a map
- Loaded a phase

Once you have done one of the previous operation then you can select an icon by ←↩
clicking over it

in the Icon Window. Note that icons are 16x16 pixel.
From now that icon becomes the currently used icon.

To put an icon in the map you simply have to click in the map window. The icon ←↩
will be placed

where you clicked.

To be precise icons aren’t placed just where you clicked. They are placed in the ←↩
nearest multiple

of 16 coordinates. For examples if you click on the coord. 20,37 the icon will be ←↩
placed at 16,32.

1.30 Selecting and Putting sprites

To put a sprite you must firstly have done one of the following operations:

- Set number of sprites
- Loaded a spt file
- Loaded a phase
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After that you have to do a slightly more complex operation than selecting and ←↩
putting an icon.

SELECTING SPRITE:

Make sure that the Sprite Window is open.
You can see tree gadget over a series of images in a grid.
At the top of the window there are "Sprite" and "Max" signs.
Both are followed by a number. The number next to "Sprite" means the number of ←↩

the sprite (not
the image) you are attaching the image. In a map you can select a limited number ←↩

of sprites
(33 - from 0 to 32).
It may change color:

- green (or any non-red color): You can use/place/change its image.
- red: the sprite is used by a previous sprite. It’s forzen: this because some ←↩

objects like tanks
chops use more than one sprite. For examples an enemy Tank uses three ←↩

sprites:
one for the body, one for the turret and one for the light.
You can free those sprites by changing the sprite which is using them. ( ←↩

its number appears
in a requester if you try to use a frozen sprite)

The number next to "Max" tells you how many sprites are present in the map. You ←↩
have to assign for

each sprite an image and you must place it in the map.

You can select the number of the sprite currently used by clicking on the PREV ( ←↩
previous) or Next

gadget.
Currently used sprites will have their sprite number on the map marked in red. ( ←↩

in sprites text are
enabled)
Clicking on the FIND gadget the currently used sprite will be found in the map.

To select the image (or better, the kind of the object you’re placing) you have ←↩
to click over the

image in the sprite window. The selected object will become the currently used ←↩
image.

Make sure you have enough sprites left.

TO PUT THE SPRITE:

Click in the map and the sprite will be placed EXACTLY where you have clicked.

CHOPS:

There are four types of Choppers:

- Unarmed
- With Bomb
- With rockets
- With IR missiles
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They are marked by the color of the tail (sorry I couldn’t find better way)

Note: last chops images are for the Helicopters which aren’t available unless you ←↩
haven’t activated

all the switches.

1.31 Finding sprites on the map

See Sprite Window or Selecting and putting a sprite.

1.32 Setting map Dimension

NOTE: IF YOU CHANGE THE DIMENSION ALL YOUR WORK WILL BE DESTROYED

Select from the Edit menu "Change dim". A window will open and you’ll have to
put in the gadget the dimensions. Note that they aren’t in pixel but in x16 pixel ←↩

.

MINIMUM DIMENSIONS: 19x15
MAXIMUM DIMENSIONS: 100x75 (Thank to Alexi Tzitzas!)

See prefs for another detail.

1.33 Changin number of sprites

NOTE: CHANGING THE TOTAL NUMBER OF SPRITES WILL ERASE ALL SPRITE POSITION

Select from the Edit menu "Change max spr". A window will appear and you’ll be
able to insert the number of sprites. You can insert any number from 1 to 32. For ←↩

example if you
insert 1, there will be 2 sprites.

1.34 Creating a new map

Do as follows:

- Select the terrain type
- Select the dimension of the map
- Select and put icons in the map until you haven’t finished (but save regularly ←↩

too)
- Save your work

And to place sprites too:

- Select and put sprites
- Save your work Saving the SPT file only or both the spt and the map files
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1.35 Chose terrain type

To change terrain type you should do as follows:
-go in the Edit menu and select in the Base submenu you terrain type.

The terrain type must be chosen at the start of the work.

1.36 Base

Available bases are:

- Jungle0
- Jungle1
- Moor
- City (internal bases)
- Ice
- Desert

There some differences between Jungle0 and Jungle1.

1.37 Loading and Saving maps

Go in the Project Menu and select load map or save map.
An ASL file requester will appear.

1.38 Loading and Saving sprites positions

Go in the Project Menu and select load SPT or save SPT.
An ASL file requester will appear.

1.39 Loading and Saving phases

A phase consists of a .map and a .SPT file. This will let you to save both file ←↩
without having

to save them separately.

Go in the Project Menu and select load SPT or save SPT.
An ASL file requester will appear.

1.40 Preferences
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CFME allows you to set some parameters as you like.

Generals:

Save WorkDir: CFME will save the path where you load and save in if this ←↩
gadget is selected.

SnapShot Window: Selecting this gadget positions and sizes of the windows will be ←↩
saved.

Startup:

Base to load at startup : the base that will be selected when CFME is launched
Dimensions : same thing
N of sprite : same thing

Save every: It will save your work every

Minutes: checking this gadget your work will be saved every the selected number ←↩
of minutes.

Changes: checking this gadget your work will be saved every the selected number ←↩
of changes.

NOTE: If you don’t do anything CFME will not save every the selected
minutes. It will save your work if you do a change after xx minutes
(where xx are the minutes chosen)

MENU:
Last Saved : restore your last settings
Reset to default: guest ;-)
Screen mode : see How to change screen mode
Colour & Palette: see How to change palette

Save, Use, Cancel: Mmmmh What will those gadget do? :-)))

1.41 Showing sprites on the map

TO SHOW/HIDE SPRITES:

Go in the Map menu and select the checkmenu "NO SPRITE".
If it is checked, sprite won’t be shown else they will.

TO SHOW SPRITE NUMBER:

Go in the Map menu and select the checkmenu "Show numbers".
If it is checked, sprite number will be shown else they will not.

TO SELECT THE TYPE OF TEXT:

Texts in the map can be transparent or solid. Sometimes it can be transparent but ←↩
often it is better

when it has the borders.

Go in the Map menu and select the checkmenu "Text+Borders".
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If it is checked, sprite number will be shown with borders else they will be ←↩
transparent.

1.42 Tooltypes

Tooltypes:

LANGUAGE=lang (lang can be italiano or english - but you can built your
catalog file - don’t forget to send it to me!)

LOCALE=dir (the directory where are the catalog files. It MUST end with : or ←↩
/)

All TOOLTYPES have more priority than ENV: or DEFAULT settings.

List of default settings:

LOCALE: default setting is LOCALE:Catalogs/
LANGUAGE: default setting is english

Priority list:

-Internal prefs (set by the preferences in CFME) HIGHER PRIORITY
-External prefs (ToolTypes)
-ENV: vars
-Default settings LOWER PRIORITY

1.43 Bug report

If you find a bug or you you have an idea, a suggestion, a comment or you want
to help me (for example sending catalogs file) you can contact the Author

Please be precise; you have to tell me at least:

- Your configuration (I would be glad if you send me your library,
devices, patches etc... list)

- Your free mem when you loaded CFME and when the bug appears
- What’s the bug (example: my system crashes)
- How do I for let the bug appear (example: I load CFME then I... so I write

in a newshell "I love PCs" and suddently my computer crashes :) )

1.44 Bug

Limitations/Bugs

Bugs:
-... sometimes ... it crashes !!! (Therefore I suggest you to save your
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work on RAM: and not directly on HD)
-if you haven’t got enough ram it can crash. Don’t run many applications
if you can run out of memory. (I will fix it next)

Limitations
-CFME can’t edit RNC crunched files. If your *.Map files are crunched
you have to decrunch them manually.

1.45 History

History

- July 98:
Discovered CF maps structure
Discovered how to rip graphics

- August 98:
Done the first (almost) complete version of CFME. (v 0.48)
Discovered some bugs.

- September 98:
Finished version 0.60 (some bug fixes, localization preferences)

- Novemeber 98:
AAAARGH! My HD died! All my work lost!
Luckily I managed to resume great part of it!

- February 99:
Another bug fixed.
Data criptation removed.

- April 99:
Some bug fixed.
Finished version 1.00b.

- 22 July 99 - V1.00b (First Aminet Release!!)

- 23 July 99 - V1.00b (Second Aminet Release!!!)
Tested on various KS: on 1.3 it crashes!
(Well I will not try to support it - it’s too limited)
Discovered (but not fixed :-( ) a bug
Done the guide.

- 24 July 99 - V1.1
done the grid option

- 24 July 99 - V1.2
done the "Screen Mode" option

- 24 July 99 - V1.3
Bugs Fixed:
No more crashes if windows are larger than screen
Grid bug fixed.

- 24 July 99 - V1.4 (Third Aminet release)
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Guide Upgraded
Bug Fixed:
Very great, ugly, ect... bug discovered and fixed (I hope...)

- 25 July 99 - V1.41
Bux Fixed:
Load_Map bug discovered and fixed.

- 26 July 99 - V1.5a
Screen Mode Depth Adjustable
Screen Pens changeable ("Colours" option in preferences) (thank to Andy)
Graphics Board Support (However don’t try to use a screen depth greather
than 8 Bits - colours options won’t work )

- 27 July 99 - V1.5
Palette option (tnx, Xaltuton :-) )
Icon Window Grid Option
Bug fixed:
Colour option won’t lock your system if you are usign screen depths > 8B

- 28 July 99 - V1.5 (4th Aminet Release!)

- 28 July 99 - V1.51 (One hour later than upload :-( )
Found another bug (Thank to Alexi) in load routine
Fixed limits for maps dimensions (Another thank to Alexi)

- 29 July 99 - V1.6 (5th Aminet release!)
Done Block Option
Done Block Save & Load. See Blocks for more
informations

- 29 july 99 - V1.61
Fixed Map Bug: CFME won’t let blank icons at edges anymore.

- 30 July 99 - V1.62
Fixed preferences’ "Use" option bug.

- 30 July 99 - V1.63b
Done a primitive "internal bug checker".

- 30 July 99 - V1.64b
Fixed (another) save .spt bug

- 31 July 99 - V1.70
Updated english catalog
Updated locale emulation
Done the objective editor! (Thank to Andrzej Pinczuk who send me a non
crunched exe - those one which is included)

- 1 August 99 - V1.80 (6th Aminet Release)
Various bugs found and fixed (Thank to Alexi Tzitzas)
Installer
Difficulty levels editor

- 2 August 99 - V1.80/1.00b
Done .blk file converter
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- 6 August 99 - V1.90/1.01 (7 Aminet Release)
Done .swp file editor (ie how icons change when they are hit by an explosion)
Increased speed of BLK TO IFF conversion (On my system the time taken
for this conversion was 4.1 s; now 0.76 s !!)

1.46 Future

Some things to do:
- Local sounds in the maps
- clean up the guide.
- Update Catalogs file
- CF 2 support ?

1.47 The Author

The Author:

WRITE ME ALL YOUR SUGGESTIONS, BUG REPORTS ECC...
HELP ME TO MAKE IT BETTER!! (and help me to discover all English mistakes =) )

PLEASE REGISTER!!! (REGISTRATION FEE IS 0!!! IT’S FREE!!! But donations,
gifts, timebombs etc... won’t be rejected! ;-) )

Nicola Wrachien
Via Capodistria 5 - 31100 Treviso (TV)
ITALY
wrachien@libero.it

Please, write me your configuration so I can support you better! (patches
OS, CPU, memory, HD, etc...) and don’t forget to tell me the version
of CFME you own!

I will answer you as soon as possible (the day after your email)

See you on #amiga and #amigaita (I’m PETN - pentrite)

Visit Leki’s Web Site: http://web.ukonline.co.uk/alexi.t/index.html
to get Hd installers, latest Versions of CFME, Maps etc...

1.48 Thanks

I would thank Urban Dominik Müller for Aminet. I think that, without his creation ←↩
, Amiga would be

died. Thanks Urban!

Greetings go to:

- Andrzej Pinczuk from Poland : Thanks for your suggestions (palette ect);-)
and for allowing me to do obj. ands .dif editors!

- Alexi Tzitzas :-) : Thanks for your informations, Bug reports, Maps!
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- sTRinG of eX-cHaOs
- Paul Qureshi (for allowing me to include a - future - RNC (de)cruncher :))

1.49 Machine it was tested on

TESTED ON:

My configurations:

Amiga 1200: 2MB Chip, 48MB Fast, PowerUp M68LC040@25MHz
603@160MHz, WB&KS 3.1, HD 1.6 GB, CD ROM SCSI2 12x
Second disk drive. (IT WORKS)

AMIGA 1200: (the same but with the PowerUp disabled
i.e. without any Fast Ram and with a 020) (IT WORKS)

UAE(Argh!): It works with WB and KS 2.0 or greater and 1.5 Mb of Ram
CFME works with graphics card emultaion too. (IT WORKS)

Other users configurations:

AMIGA 1200: 030/50 MHz, 16 MB Fast Ram, Dopus, OS 3.1

AMIGA 1200: Apollo 1240/40 MHz, OS3.0, 32MB Fast Ram, HD 1GB, CD-ROM
Patches installed: OXYPATCHER, PATCHWPA8, FVB, FBLIT (IT WORKS)

A1200 T : Power Up 603 240 MHz, 68040@25MHz (FPU/MMU), 32MB Fast
HD 4.3GB, CD ROM 24x, extra disk drive, Modem 56KBaud/s, OS 3.1
(IT WORKS)

A1200 T : Same as the previous (without Fast, 040) (IT WORKS)
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